
Fire Family Plus is a tool for organizing and displaying weather data.  In order to produce the most usable output it is 
important to consider the following.  

- Use local knowledge when selecting a RAWS station and picking the most meaningful NFDRS variable (BI, ERC, KBDI, 
SC)

- Fire Family Plus takes the weather information recorded from RAWS stations and applies models to calculate fuel 
moisture – the same limitations with models exist. 

Visit  firelab.org to download the latest version of FFP and refer to the users guide for more detailed instructions (see the 
options in the lower right of the page for downloads and documents).
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Overview of Major Steps: 
1. Find a RAWS station
2. Extracting historical weather and fire data
3. Summarizing the weather
4. Exporting weather data

This is a basic overview – Additional 
information can be obtained from the FFP help 
function. 

Significant changes are expected for the next 
version of FFP

https://www.firelab.org/project/firefamilyplus


Download Fire Family Plus

College of Natural Resources

FF+ is a program that can be run by most computers and 
operating systems and does not need high speed processing. 

This website is frequently being updated. If things look 
different just look around for the current version. 

a. Go to https://www.firelab.org/project/firefamilyplus

b. Select FireFamilyPlus Current Version

c. Follow the download instructions. 

d. See the FireFamilyPlus Job Aids for additional instructions. 
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https://www.firelab.org/project/firefamilyplus


Getting data
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2.1 Selecting a RAWS
1. Go to https://wfas.net/index.php/google-earth-map-data-weather-100
2. Download the WFAS Google Earth Map data file in KMZ format OR the auto-

updating KML file if you want to use this as a way to monitor weather. 
3. In Google Earth explore the location of the RAWS station. 
4. The “right” RAWS station depends on your project objectives. 
5. Variables to consider

1. Proximity to project
2. Elevation
3. Aspect
4. Topographic features (drainages)
5. Fuel model

6. You may need more than one RAWS to represent your area. 

2.2 Historic Hourly Data
a. Go to https://www.wfas.net/nfdrs2016/maps/
b. Zoom to area of interest.
c. Download any possible RAWS that could be representative to your area of 

interest (fig. 2) (1). (You can explore that data more fully in FF+ to determine 
the best match for your area)

d. Change the name of the downloaded file to indicate that it came from the 
WFAS site (this will help with the import process)

e. Record the station ID you will need it to download current data. (2)
If you know the station ID but not the location you can find this same data from 
the CEFA site. CEFA RAWS FW13
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Fig. 2

Fig. 1

https://wfas.net/index.php/google-earth-map-data-weather-100
https://www.wfas.net/nfdrs2016/maps/
https://cefa.dri.edu/raws/


Getting data
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2.3 Recent Hourly Data  – https://famit.nwcg.gov/applications/FAMWeb This 
site also has historic daily data but not data but the download is slower. It is 
recommended that you download from WFAS first and fill in current dates with 
FAM-IT. 

a. Select Public Access Reports – click OK to go to an external site
b. Team content tab on the left (fig. 1(1)

Weather data
a. Go to Weather Data Extract (fig. 1(2))

b. Select Historical >> FW13

c. Enter station ID
d. Select dates, either the whole range that you need or just the time that is not 

covered by the WFAS data. (fig.2)

e. Select Hourly and then Finish in the bottom left

f. The file will be saved in your downloads folder. Change the name to something 
meaningful AND add “.fw13” as the extension (fig. 3)

g. Add “DW” to the file name so that you know it came from the data 
warehouse. 

TIP, if you do not see the suffix of your other files. For Window, open your file 
explorer, choose the View tab and check File name extensions (fig. 4)

Station catalog data files

a. Weather data extract>>Station catalog data extract>>

b. Select Station Information S..Catalog by Station(fig. 5)
c. Enter RAWS Station ID and click Finish in the bottom left

d. Save the file with a .txt extension 

Fire data
a. Coming soon

How-to: Use Fire Family Plus
Fig. 2

2

Fig. 1

1

3 Fig. 3

Fig. 4

Fig. 5

https://famit.nwcg.gov/applications/FAMWeb


Getting started
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3.1 – Importing 

a. Open FFP

b. Select File >>New and name the project that you will be 
working on

c. Select Data >> Import 

d. Weather - select FW9/FW13 Files (fig. 1)

e. Select the FW13 file that you downloaded.  Check that 
“0 errors were encountered” and some number of 
records were recorded (fig. 2).  If you encountered 
errors, open the files in a notepad and remove or 
resolve the errors. 

f. Fires – select each agency you have data for and import 
the RAW file. 

g. Close out the import windows

h. Under SIG/Station select the station that you just 
imported (fig. 3)

i. Fire Associations – for each agency, navigate to the 
national forest where you have data (fig. 4)

5

How-to: Use Fire Family Plus

Fig. 2

Fig. 1

Fig. 3
Fig. 4



Getting started
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3.1 – Creating a SIG – Special Interest Group

a. Go to Data>>SIG>>New

b. Add name and description and move stations into 
Included stations using the side arrows (fig. 1). Click OK

c. Setting weights - Helpful if one station is more 
representative of an area than another. From the Special 
Interest Group Dialog box select Set Weights

Equal numbers mean equal weights, if one is higher 
then the values from that RAWS have more impact on 
the final numbers given from the SIG. 

a. Click OK and then Close to save and exit.

e. To edit the SIG go to Data>>SIG and edit, delete, or 
export metadata. 
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Fig. 4

What is a SIG? A Special Interest Group is a combination of 
weather stations for an area.  A SIG can be useful if 
1. You have an area that is too large to be represented by 1 
RAWS station

Fig. 2

Fig. 1



Getting started
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a. Year range  (fig. 1)(1)– To look at what may happen in the future only include 5 to 15 years 
of data depending on what you feel is representative of current conditions. If you are 
trying to understand trends from the past, then you will use all available data. 

b. Annual Filter (Time of Year) (2) – Limit the months based on your modeling objectives. If 
you are modeling fire in August, then filter to just August. 

c. Analysis Period Length (3)– If creating graphs in Climatology, using 3 or 4 days will even 
out the display. Using 1 day will give you the most accurate report of the actual values. 

d. NFDRS Fuel Model– (4) NFDRS got a facelift. As part of that you can now use simplified 
NFDRS fuel models but you will need to select the new NFDRS fuel model from the 
list. Observe what the default fuel model is and then select the new fuel model based on 
the table 1.
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NFDRS 2016 Fuel Type NFDRS 2016 
Fuel Model

Equivalent NFDRS 1978 Fuel 
Model

Grass V A,L,T

Grass / Shrub W R,S,C,D

Brush X B, F

Timber Y G,H,N,P,O,Q,U,E

Slash Z I,J,K

Fig. 1

Table 1
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Climatology 
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See the FFP TechTips for detailed Climatology functions

4.1 – Exploring  and displaying data

a. To view full weather record go to Weather >> View 
Observations. 

b. To great data summaries go to Weather >> Climatology or 
click on the storm cloud icon (fig. 1 (1)

a. Explore the available outputs, check a box and select Run

c. Changing the values in CP #1 and CP#2 (critical percentile) the 
display lines on the graph. (fig.2)

d. Select Daily Freqs for a summary of the number of 
observations in each percentile (fig. 3). Ex. if you selected an 
analysis period of 10 days and the frequency was 36 that 
means that between 1997 and 2017 there were 36 times 
where the average 10 day temperature was 92 degrees.  
Changing the years, analysis period and annual filter will 
change this number but each output will give you an idea of 
the broad scale weather patterns and percentiles. 

e. To expand the graph window of a report, double-click on it.

f. To tile the many report window select Window>>Tile 
Horizonal or vertical. 
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https://www.firelab.org/sites/default/files/images/downloads/FFP_TechTips.pdf


Climatology 
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See the FFP User’s Guide 4.14 for detailed instructions on 
merging graphs

4.2 – Merging graphs

a. Once you have run the climatology tool and have several 
graphs created, you can create a combined graph for up to 4 
variables of interest 

b. Select Option >> Merge

c. Choose the years to graph, or select Average (fig. 1)

d. Specify the variables and style, click OK (fig. 2) Common 
combinations are:

a. Temp, RH, BI

b. 1 hr, 10 hr, 100 hr, 1000 hr. 

c. Herbaceous fuel moisture, woody fuel moisture

4.3 – Overlay 

a. After creating a Stats Graph go to Options >> Overlays and 
select New to add one or more overlays (fig. 3). 

See the FFP User’s Guide 4.16 for more information on changing the 
look of your graphs (fig. 4)
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https://www.firelab.org/sites/default/files/images/downloads/FFP-4_1_Draft_Users_Guide_0.pdf
https://www.firelab.org/sites/default/files/images/downloads/FFP-4_1_Draft_Users_Guide_0.pdf


Climatology 

College of Natural Resources

4.3 – Season Ending Event

Calculate the likelihood of a season ending event at any given time 
of year. 

a. In Climatology change the CP#1 to 60 for ERC. An ERC of 60 is 
considered to be a  season ending event (fig.1). Click Run. 

b. Using the overlay option display at least 5 years and record the 
dates that the ERC went below 60. More dates will give you 
more accuracy. Occasionally it will go back up, use your best 
judgement on when the season really ended. You can display 
up to 3 overlays at a time (fig. 2). Make sure to select Apply 
(1). To pinpoint the date, click where the overlay crosses the 
60% line and it will display in the lower right (2). 

c. Go to Weather >> Term >> General and select New. 

d. Select the station name or ID and select OK

e. Create a specific name and enter the days you recorded (fig.1) 
and select Save & Run. 

f. The results show the key probabilities of the weather 
conditions for the days you inputted being met at given dates 
(fig. 4)  
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Other tools
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5.1 – Event locator 

After determining the acceptable ranges for a prescription in 
BehavePlus, use the event locator to see how many days have met 
that prescription in the past.  If there are very limited days that fit 
your criteria you many need to go back to Behave to test other input 
possibilities. 
a. Go to Weather >> Event Locator 

b. Specify the period length or consecutive days that need to meet the 
criteria.  (figure 1)

a. For best results specify upper and lower values for each variable. 
5.2 – Wind rose
a. Go to Weather >> Winds
b. Specify Wind record type and Diurnal wind filters

Explore each individual wind rose first to observe general patterns. It may 
be useful to then group by day vs. night. You many need to adjust which 
hours are included in day and night depending on when winds change in 
your area.  It is also helpful to view average winds and wind gusts 
separately. 

TIP: To view multiple outputs you can select Window >> Tile Horizontal. To 
close all reports and graphs go to Window >> Close all >> Reports and 
Graphs. For higher quality figures you can go to File>> Save as and specify 
the file type. 

This indicates where the wind is coming FROM – ex. for the SHOCK RAWS 
station the wind comes from the south at night and the north west during the 
day 11
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Other tools
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See the FFP User’s Guide 6.14 for other options in Season 
Reports

5.3 – Probability analysis 

Reports the chance that tomorrow’s variable will be the same 
as today’s. The higher the percentage more likely it is that you 
will see the same weather (FFP UG 2009)

a. Go to Weather >> Seasonal Reports >> Probability analysis 

b. You may need to type in the display ranges as shown in the UG

5.4 – Percentile weather

“Identifies the frequency of occurrence of a particular variable 
of your choice” (FFP UG 2009)

a. Go to  Weather >> Seasonal Reports >> Percentile weather

b. Select a variable 

c. Choose predominant wind direction(s)

d. Click Calculate (1), Calculate (2), Done (3)
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https://www.firelab.org/sites/default/files/images/downloads/FFP-4_1_Draft_Users_Guide_0.pdf


Exporting data
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Exporting data →Go to Weather>>Hourly Listing and select 
the data that you want and how you want it to be formatted 
(fig. 1)

6.1 – Hourly summary in Excel
a. Once the table is created select File>> Save as 

b. Open Excel.  Select Open and navigate to the folder of the.txt file. 

c. In the bottom right of the Open box select All files

d. Select Delimited then Next and choose Space and click Next and Finished

e. Delete the Station information rows so that the top row is the column title

f. From the Insert tab select Pivot table

g. For Table/Range click the up arrow and select all the data columns (fig. 2). 

h. For location use the up arrow and select the cell where you want the table 
to go. (use ctrl+shift+down arrow to highlight them all)

i. In the Pivot table options to the right Check YYYY/MM/DD and hh:mm (fig. 
3(1)

j. For Values insert 1 h, 10 h and change to Average (2)

k. Place curser on a cell with a date listed.  On the Analyze tab select Ungroup 
and then Group Selection and select Months and Hours

l. Copy and paste all the data for the month you are interested out of the 
pivot table and add column labels. 

m. Create a line graph comparing 1, 10, 100, and 1000 hr fuel moistures

n. Add and adjust figure elements. 

13

How-to: Use Fire Family Plus

21

1

Fig. 1

FireFamily Plus has the basic functions needed to understand the weather but further analysis can 
be performed using other more computationally intensive programs like Excel, R and Python. 

Fig. 2

Fig. 3


